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Introduction

Act! helps organize all your prospect and customer details in one place so you can prioritize your day and
market your products and services more effectively, driving sales results while creating customers for life.

Who Should Use This Guide?
You should use this guide if you have any version of ACT!, ACT! by Sage, Sage ACT!, or Act! Pro, Premium or
Web later than 2007 (8.x). To determine the version of the product you are using, check the version number
(from the Help menu, select About).

If you do not have one of the previous versions installed, then DO NOT USE this guide. Instead, see the
appropriate guide:

If your current version is... Then...

I do not have any version of Act! installed. I
am a "New User."

Use the Installing Act! for New Users guide to install, register, and activate
Act!.

I have ACT! 2005 (7.x) or 2006 (8.x) installed.
My installation may or may not include the
web.

Contact Act! Technical Support. Upgrade assistance is required due to
Microsoft obsolescence policies.

The guides are available on the installation panel under Product Documentation. Adobe® Reader® is required
to access and view product documentation.

About This Guide
This guide explains how to upgrade Act!.

Act! Premium includes access via Windows® (desktop) and web. If you are installing access for users via the
web, then you will need this guide and the Act! Premium Web Administrator's Guide to complete installation and
configuration. The Web Administrator's Guide is available on the web product's installation panel under Product
Documentation. You can browse the installation files directory for the guide as well. We recommend that you
read the Web Administrator's Guide before installing the web version.

Features exclusive to Act! Premium or Act! Premium (access via web) are noted in the guide. In most sections,
we refer to all versions as Act!.
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Who Can Install This Upgrade?
You can install this upgrade if:

l You are a single user with an Act! database on your computer and that database is Microsoft® SQL
Server® 2005 Express, or later. Earlier SQL Server databases may not upgrade due to Microsoft
obsolescence policies. Review all Act! installation messages for details.

l You are one of several users accessing the same database and that database is not on your computer.

Use this document to apply the upgrade to every computer that accesses Act!, including the computer
hosting the database. Make sure all users are upgraded at the same time to prevent issues accessing the
database.

l You are an ACT! Premium for Web, ACT! by Sage Premium for Web, Sage ACT! Premium (access via
web), or Act! Premium (access via web) user.

To upgrade your current web product, you need this guide and the Act! Premium Web Administrator's
Guide to complete installation and configuration. The Web Administrator's Guide is available as a PDF on
the installation panel under Product Documentation.

What You Should Know Before Upgrading
Before upgrading, you should understand:

l Upgrade considerations and recommendations.

l Database synchronization recommendations.

l Items that do not upgrade.

Be sure to read the entire upgrading document before beginning the upgrade.

Database Upgrade Considerations and Recommendations
The upgrade process involves upgrading an existing database. Review the following considerations and
recommendations before you upgrade.

The database upgrade process overwrites the earlier version database. It is important to have a backup copy
of the database in case you want to re-install the earlier version of the software. Back up the database before
starting the upgrade process.

Who can upgrade a database? An Administrator or Manager user can upgrade a local database. An
Administrator, Manager, or Standard user (if there is no active Administrator user) can upgrade a remote
(Subscriber) synchronized database they belong to. See the section "Database Synchronization Requirements"
for information about whether or not you can upgrade a remote database.

No upgrade required for database supplemental files. Database supplemental files, such as templates,
reports, and layouts, do not need to be upgraded.

Database Synchronization Recommendations
Customers upgrading from ACT! by Sage 2010 (12.x) and later do not need to recreate their remote databases.
You can upgrade a remote database after you install Act!. However, customers on versions earlier than ACT! by
Sage 2010 (12.x) should follow these recommendations.

ACT! by Sage or ACT! by Sage Premium 2007 (9.x), 2008 (10.x), or 2009 (11.x) customers. The database
synchronization relationship is retained. However, because of opportunity data changes made in ACT! by Sage
2010, we recommend that you synchronize remote databases to one, main (Publisher) database before
upgrading. Then, you upgrade the main database and create new remote databases. The new opportunity data
changes will synchronize.

You can create up to 50 remote databases at one time.
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Items That Do Not Upgrade
Note the following items that do not upgrade.

Menu/toolbar and column customizations. Customizations are lost. You must redo your menu/toolbar and
column customizations. See the Help for information about menus and toolbars you can customize.

Welcome Page customizations. If an Act! Certified Consultant* customized the Welcome Page in ACT! by Sage
2010 or ACT! by Sage Premium 2010 for you, these customizations are lost when you upgrade.

Database synchronization Accept Incoming Syncs ON setting. The ON setting for Accept Incoming Syncs is
disabled for customers upgrading from ACT! by Sage 2007 (9.x) and later versions. You must turn database
synchronization ON (Tools > Synchronize Database > Accept Incoming Syncs). The port number is retained.

Act! Synchronization Services (Network and Internet Synchronization Services). You must uninstall earlier
versions of the Sync services, and then install the latest version. To uninstall a Sync service, use Control
Panel>Add/Remove Programs. To install the new versions, see "Installing Other Applications" on page 7.
*Certified Consultants are third-party vendors. Swiftpage ACT! and its affiliates are in no way liable or responsible for claims made related to the

services provided by third-party vendors.

Upgrade Checklist
The following checklist outlines the tasks needed to upgrade Act!.

ü Task Page
#

Understand what happens during the upgrade process. ii

Prepare to install. Important: If your installation includes access via the web, be sure to complete both sets of
steps. 1

Install, register, and activate Act! Premium (access via web). 3

Upgrade the database. Important: Ensure the database remained shared. If not, share it. 4

Install Act! Sync Services. Note: If you used previous versions of Act! Sync Services, you must uninstall them and
install the current version. 7

See the Act! Premium Web Administrator's Guide to configure access via the web.
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Installing Act!

The following sections explain the required components, other considerations, and how to:

l Prepare to install.

l Install Act!.

l Register and activate the software.

l Upgrade your database.

Several final sections explain upgrade changes that may affect where your data appears and other information
you may need to know.

Required Components
To install and function correctly, Act! requires the following components:

l Windows® Installer 4.5

l .NET Framework 4.0

l Microsoft® SQL Server® 2008 R2 or later

If you do not have a required component, it is installed for you.

NOTE: You can choose not to install SQL Server Express if users will be connecting to a shared Act! database
with SQL Server. However, SQL Server Express must be installed on the computer hosting the shared
database. For Act! Premium (access via web) users, SQL Server Express must be installed on the database
server or web server, depending on your configuration. See the Act! Premium Web Administrator's Guide.

Other Considerations
Other add-on products. Some applications added as plug-ins or add-on products in earlier versions may not
upgrade. These applications may require re-installation after installing the software. Visit the Marketplace or
contact your add-on product provider to determine compatibility.

Microsoft Outlook®, Word, and Excel® integration. Act! integrates with Microsoft Outlook, Word, and Excel.
(For compatible versions, see System Requirements at www.act.com/systreq.) If you plan to use the integration
features, ensure the Microsoft software is installed and working correctly before installing Act!. You must set up
an Outlook profile. To configure and set up integration for Act! Premium users after installation, see "About
Microsoft Outlook Integration" in Help. To configure and set up integration for Act! Premium (access via web)
users, see the Act! Premium Web Administrator's Guide.

Preparing to Install
Before installation, complete these steps in the order presented. If you plan to install Act! Premium (access via
web), you must also complete the second set of steps.

Prepare to install
1. Ensure your computer (or all computers in a shared environment) meet the minimum recommended

system requirements for your purchased product and operating system. Also, verify you meet the
concurrent user limits and licenses. See system requirements at: www.act.com/systreq.
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2. Ensure you are current with Microsoft critical and recommended updates.

3. Restart all computers to free available resources before you install.

4. Sign on to all computers as a Microsoft Windows Administrator. If you do not, installation may fail.

5. (Recommended) Disable any software-based firewalls. You can enable these after installation.

6. Act! integrates with versions of Microsoft Outlook, Word and Excel. For compatible versions, see
www.act.com/systreq. Ensure the Microsoft software is installed and working correctly before installing
Act!. You must have an Outlook profile configured for Outlook integration setup.

7. Customers on ACT! by Sage Premium 2009 (11.x) only: Synchronize remote databases to one, main
database. After you install and upgrade the database, you can create new remote databases.

8. Open your current Act! version and perform database maintenance. On the Tools menu, click Database
Maintenance.

Prepare to install or upgrade to Act! Premium (access via web)
1. Act! Premium requires that Microsoft Internet Information Services (IIS) 6 and ASP.NET run in 32-bit

compatibility mode. If you use 64-bit versions of these applications and do not want the installer to
switch them to 32-bit mode, see the solution under "General Errors and Issues" in the
"Troubleshooting Act! Premium (access via web)" section of the Act! Premium Web Administrator's
Guide. IIS 7 allows both 32-bit and 64-bit processes to run simultaneously.

2. See Microsoft documentation to help you plan your installation and prepare your web server. You
need to understand your operating system, IIS, ASP.NET, and user permissions required to run a web
page.

3. Install, or enable, the correct version of IIS for your operating system. Verify it runs properly. Some
supported operating systems automatically install IIS, however, you may have to enable it.

4. Install ASP.NET or verify that ASP.NET impersonation authentication is enabled.

5. If you are using a firewall, enable an exception for World Wide Web services.

6. Give your web server a static IP address and make a note of it. You will need it later when you
configure access.

7. Gather the virtual directory or virtual server names of other web sites hosted on your web server.

8. If you use Windows Vista® as a web server to host Act! Premium (access via web), change the "sleep
mode" setting to Never.

9. Customers on earlier versions of Act! Premium (access via web):

a. Have web users log off the Act! database.

b. Open Act! and use the Web Administration tool to remove the database from the web site. Once
the database upgrade is complete, you can add the database back to the web site and reset IIS.
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Installing Act!
IMPORTANT: If you are installing Act! Premium (access via web) in a multiple-server configuration, install the
application on the database server (even though you will be running it from the web server). Installing on the
database server creates the Microsoft SQL Server instance for Act!. You connect to the database from the web
server. For upgrading customers, install Act! Premium (access via web) on the server with the earlier version.

Install Act! (all versions)
1. Close all open applications.

2. Do one of the following:

l Complete the download process from the Act! web site.

l Double-click the setup.exe file if you are installing from a network location.

NOTE: In the installation process, if a message appears about Microsoft .Net Framework 4 Client
Profile, you can click OK to continue. No action is necessary.

3. On the main installation screen, click Install Act!.
4. On the Installation Requirements page, review the information. Click Install to continue.
5. If prompted, agree to install the required components. A restart may be necessary after installation.

NOTE: If the installation does not automatically start after a required restart, click Setup.exe to continue.
6. On the Regional Version page, select the version to install. Click Next.
7. At the "...Earlier version detected and needs to be uninstalled" message, click Yes to continue.
8. On the License Agreement page, read the agreement, and then click Accept.
9. On the Type of Install page, Typical installation is selected by default. To change the default install

settings, select Custom. Click Next.

NOTE:With a Custom installation, you can select to install Act! without SQL Server Express. To do this,
clear the Install SQL Server Express check box on the next page. IMPORTANT: If you do not install SQL
Server Express, you cannot create or restore a database. However, you can connect to a shared
database. Other custom options let you choose where to install Act! and SQL Server Express, select
who can use Act!, specify icons for Quick Launch, and where to place Act! in the Start Menu.

10. When the Install Complete page appears, click Finish.
11. To close the installation panel, click Exit.

To open Act!: Double-click the Act! icon on the desktop. Or, on the Start menu, under Programs, point to the
Act! program folder, and then click Act!. When the software opens, you are prompted to register and activate it.
You can choose to register now or use the software for a trial period of 30 days. For more information about the
trial period, see "About the Trial Period" in Help.
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Registering and Activating Act!
You must register and activate Act! within 30 days of first use on each computer where it is installed. Registration
and activation provides you with program updates and customer support options. A serial number is required to
register. The serial number is emailed to you upon purchase. You can copy the serial number from the product
activation email and paste it into the registration page.

Windows Vista andWindows 7: You must run the software as an Administrator to register it. Close Act!. Right-
click the Act! icon on the desktop or in the Program Files list. Click Run as administrator.

Register and activate the software
1. On the Helpmenu, click Register Act!.
2. Select a registration option. Click Next.
3. Follow the on-screen instructions. Click Next to advance.
4. When finished, click Activate.

Upgrading a Database
The following explains how to upgrade your database.

Upgrade a database
1. Open Act!.

or
If Act! is already open, when the logon screen appears, enter the user name and password for the
database you want to upgrade. Go to step 4.

2. On theWelcome screen, ensure Open an existing Act! database is selected, and then click OK.
3. In the Open/Share Database dialog box, select the database. Click Open Database.

If you do not see your database in the list, click Browse For Database to locate it.

You can easily locate, open, and share a database using theOpen/Share Database command on the File menu
or theWelcome screen.

4. When prompted to back up the database before upgrading, click Yes.

We recommend that you backup the database so that if you want to reinstall the earlier version of the software,
the database backup copy can be restored in that version. The upgrade processoverwrites your earlier version
database, but doesnot affect the backup copy.

5. Follow the directions on any update and verification prompts that appear.

6. When the update process is complete, click OK.
7. (Optional) If the database was shared with others, click File, then Open/Share Database to ensure it

remained shared. If it did not remain shared, click Share. To open the database, click Open Database.

Upgrade Changes That May Affect Where Your Data Appears
The following sections provide an overview of some of the significant changes in recent releases. For more
information about new and improved features for other releases, see the Knowledgebase.

Act! v18
New features, customization options, and an improved web user interface make working in Act! faster and
easier.

Global Toolbar Customizations. You can customize the global toolbar to improve your productivity and make
Act! fit the way you work.

Custom Notifications. Custom notifications allow you to send an alert type message to all users.
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Global Activity Preferences. The administrator can globally set scheduling and calendar preferences for all
users with one click.

Act! emarketing Lookups. You can use an emarketing lookup to find contacts that have opted out of your email
campaigns or that have an invalid email address that caused the email campaign to bounce back.

Original Scheduled Date. In the Schedule Activity dialog box, you can see the date the activity was originally
scheduled for.

Keyword Filters. You can use a keyword to filter results on the Activities and Notes tabs.
Default History Type. You can select a default history result to use when creating new histories.

Act! v17.1
Improvements to usability and discoverability of features help you work smarter in Act!.

Duplicate Checking. You can manage your duplicate checking preferences from Act! Premium (access via web)
and the Import Wizard. Access from the Import Wizard allows you to view or change your preferences specific to
the current import.

Default History Type. You can select a default history type to use when creating new histories.

Documents Tab. You can attach a shortcut to a folder using the Documents tab.
Act! emarketing Messaging.When sending an email campaign, you can see your email send limit in the Send
Campaign dialog box.

Call Lists Tab. Using the updated Call Lists tab you can select multiple contacts, create a history, schedule an
activity, create a lookup, delete a call list, and see the name of the email campaign sender.

Drop-down Lists. You can manage drop-down lists from Act! Premium (access via web) and create a drop-
down list while creating or editing a field.

Global Toolbar Customizations. You can add, remove, and reorganize the buttons on the global toolbar.
Web Info Tab. Links on the Web Info tab are global and changes apply to all users.

Act! v17
Improvements to Smart Tasks, emarketing, synchronization, and preference management help you work more
efficiently in Act!.

Updated Design. Icons and layouts were updated to improve the look and feel of Act!. A widescreen layout is
now available.

NewMarketplace view. The Connections view was renamed Marketplace. Use the Marketplace to learn more
about integrated services and features.

Limited Access and Emarketing Smart Tasks. You can use Smart Tasks to set access criteria on fields and to
trigger activities based on emarketing criteria such as a call list score.

Emarketing sender profiles*. Sender profiles allow you to personalize the name that appears in the "From" field
of an emarketing email sent via an email campaign or Smart Task.

Emarketing Lead Capture. You can use Lead Capture to create webforms and capture leads from web pages,
newsletters, and more.

Create Remote Databases using Act! Premium (access via web). You can use the Web Client to create
remote databases.

1-way synchronization with Outlook. Using 1-way synchronization you can send contact and calendar
information to Outlook without sending Outlook information back to.

Act!
Globally update preferences.With one click, you can set Outlook email, word processor, and startup view
preferences as the default for all existing and new users.

Attach a URL to the Documents tab. In addition to Files and Shortcuts, you can attach a URL as a document on
the Documents tab.

Hide Inactive users. You can hide Inactive users so that they do not appear in Schedule For and Record
Manager lists. When you activate this feature, only active users appear in the Schedule For and Record
Manager lists.

Upgrading to Act! v20 from ACT! Versions 2005 (7.x) and Later 5



Contact timeline. The Timeline tab allows you to view your contact interactions at a glance, with an interactive
visual timeline.

Installation script for multi-user deployments. Silent installation lets administrators install Act! Premium on
client computers without user intervention. From the installation panel, you can create a pre-recorded installation
script to silently install Act! on Client computers.
*This featuremay require an additional fee.

Featured Integrated Solutions
Act! emarketing. Segment contacts, create and send targeted email campaigns, and prioritize hot leads all from
within Act!.

Marketplace. View additional services, some with trial periods or free levels, and links to integrated applications.
On the left navigation bar, click Marketplace.

Microsoft Outlook and Office Integration. You can integrate with Microsoft Outlook, Word, and Excel. You can
synchronize your Outlook contacts and calendar with Act!.

Google® and Gmail® Integration. You can integrate Act! with your Google contacts and calendar and record
histories of emails sent or received from your Gmail account.

Next Step(s)
Single Users:

l Read the Quick Start for New Users guide or watch Featured Videos accessed from the Help menu.

Act! Premium (access via web) Users:
1. Assign the upgraded database to the web site and reset IIS.

2. Verify access for your web users and complete other configuration tasks. See the Act! Premium Web
Administrator's Guide.

Workgroup Users:
1. Read the Quick Start for New Users guide or watch Featured Videos accessed from the Help menu.

2. If you use a shared database, ensure all users install the same Act! version. Then, you can distribute a
shortcut to the .PAD file for the database. (The .PAD file is pointer to the database. Users open a database
from the .PAD file.)

3. Create new remote databases for database synchronization (not required for previous ACT! by Sage 2010
or later users). For more information, see "About Database Synchronization" in Help.
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Installing Other Applications

This section explains how to install Act! Synchronization Services (available for Act! Premium only).

Act! Synchronization Services
Act! Premium offers two data synchronization services. These services let remote workgroup users, with their
own Act! Premium database, synchronize their data to the main workgroup database without Act! being opened
and active. You can install one or both services depending on your needs. For more information about database
synchronization, see Help.

Act! Network Synchronization Service. Lets you synchronize Act! Premium databases over a network. This
service can be used by remote users connected to the main database via a Local Area Network (LAN), Wide
Area Network (WAN), or a Virtual Private Network (VPN). You can install the service on the same computer as
Act! or on another computer.

Act! Internet Synchronization Service. Lets you synchronize Act! Premium databases over the Internet. This
service requires a computer (located outside the firewall) with ASP.NET and Microsoft Internet Information
Services (IIS) installed (compatible with your operating system). See system requirements at:
www.act.com/systreq.

NOTE: Act! Pro users can synchronize data between a main and remote database, but do not use the
synchronization services. For Act! Pro database synchronization, the Act! application must be open on the
computer hosting it. For more information, see "About Database Synchronization" in Help.

Installing Act! Synchronization Services
The following explains how to install an Act! Synchronization service. You install one service at a time. After
installation, you must configure it.

IMPORTANT: If you install the Act! Internet Synchronization Service on a computer that does not have Act!
Premium installed, ensure the <computer name>\ASPNET account has read/write permissions on the Internet
Sync install folder. For more information, see Help.

Install a Synchronization Service
1. Open the installation panel, double-click the setup.exe file, or insert the installation DVD.
2. On the installation panel, click Install Act! Synchronization Services.
3. Click the link to install a synchronization service.

If the required version of .NET Framework is not detected, it will be installed with the synchronization
service components.

4. Follow the on-screen instructions. Click Next to advance. Click Finish.

Next Step(s)
1. Set up Synchronization Services. See one of the following topics in Help:

l Setting Up and Managing the Internet Sync Service.

l Setting Up and Managing the Network Sync Service.

2. Get started using Act!.
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